BAB Il

METODE PENELITIAN

Metode penelitian yang digunakan pada pembuatan perangkat keras dan
perangkat lunak yaitu dengan studi kepustakaan. Dengan cara ini penulis berusaha
untuk mendapatkan dan mengumpulkan data-data, informasi, konsep-konsep yang
bersifat teoritis dari buku bahan-bahan kuliah dan referensi dari internet yang
berkaitan dengan permasalahan.

Dari data-data yang diperoleh maka dilakukan perencanaan rangkaian
perangkat keras. Dalam perangkat keras ini, penulis akan melakukan pengujian
perangkat keras dengan program-program yang telah dibuat, Pembuatan perangkat
lunak adalah tahap selanjutnya. Terakhir adalah penggabungan perangkar keras
dengan kerja perangkat lunak yang telah selesai dibuat.

Pada BAB Il dibahas mengenai masalah yang timbul dalam perencanaan
dan pembuatan perangkat keras (hardware) maupun perangkat lunak (software).
Dari kedua bagian tersebut akan dipadukan agar dapat bekerja sama untuk
menjalankan sistem yang baik.

Perencanaan ini diperlukan sebelum proses pembuatan system tersebut,
Perancangan ini berguna agar pengerjaan tahapan selanjutnya berjalan dengan
lancar. Tahapan-tahapannya meliputi tahap pembuatan perangkat keras, perangkat

lunak dan menggabungkan keduanya.
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3.1. Diagram Blok
Dalam pembahasan tentang proses keseluruhan yang dapat di jelaskan pada

diagram blok seperti Gambar 3.1.

SENSOR ARRAY TGS ANALOG MINIMUM SYSTEM VISUAL BASIC 6 PADA
2610,11,12 ATMEGA8 PC/LAPTOP

P L& N |

I Menghasilkan

bobot

\
I
i
!

e e pmes e s mes

(B)

Gambar 3.1. Blok diagram sistem

Dari blok diagram pada Gambar 3.1. Gambar bagian (A) memperlihatkan
blok pelatihan jaringan saraf tiruan, sedangkan Gambar bagian (B)
memperlihatkan pengujiaan jaringan saraf tiruan. Sistem ini yang terdiri dari
berbagai modul antara lain modul sensor array, modul minimum system
ATmega8, pemrograman yang terdapat pada komputer, modul FPAA AN231KO04.
Proses pertama sensor array TGS menerima input berupa gas-gas kimia.
Kemudian output dari sensor array TGS berupa data analog akan diterima
microcontroller dan dikelola sesuai program yang ada hingga mengirimkan data

digital kepada komputer melalui komunikasi serial (UART). Data-data yang
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diterima komputer akan disimpan dalam database dan diproses oleh program
jaringan saraf tiruan hingga mendapatkan nilai bobot dan bias yang sesuai, nilai
bobot dan bias yang didapatkan dari proses pelatihan akan digunakan sebagai
parameter bobot dan bias pada jaringan saraf tiruan di FPAA. Data dari sensor
array TGS akan diujikan pada jaringa saraf tiruan di modul FPAA sehingga
menghasilkan output tentang jenis gas yang telah terdeteksi. Indikator hasil
keputusan FPAA disajikan dalam bentuk LED.

3.2 Perancangan perangkat keras

3.2.1. Rangkaian array sensor TGS

Dalam tugas akhir ini digunakan 3 buah sensor TGS dari Figaro yaitu TGS
2610, 2611, dan 2612 yang memiliki karakteristik hampir mirip antara yang satu
dengan lainnya. Sesuai dengan datasheet, karakteristik gas yang dapat terdeteksi
yaitu gas-gas yang mengandung ethanol, methane, iso-butane dan propane.

Agar dapat bekerja dengan baik sensor ini membutuhkan dua tegangan
masukan. Heater Voltage (Vy) digunakan sebagai tegangan heater dan Circuit
Voltage (Vc) merupakan tegangan supply rangkaian, keduanya diberikan catu
daya sebasar 5 volt DC. Nilai resistor beban (R.) dapat dipilih atau di-adjust untuk
mengoptimasikan nilai alarm threshold, menjaga power dissipation (Ps)
semikonduktor di bawah batas 15mW. Power dissipation (Ps) akan menjadi
sangat tinggi ketika nilai Rs adalah sama dengan nilai R.. Nilai power dissipation
(Ps) dan hambatan sensor (Rs) dapat dihitung dengan persamaan (3.1) dan (3.1).

VC — VRL)?
pe _ (VC=VRLY:

= (3.1)

R _VC—VRL RL 3.
s = VAL X (3.2)
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Untuk mengatur Vy dan pengambilan data analog yang dihasilkan Vg digunakan
rangkaian yang terdiri dari relay, transistor, resistor, serta dioda sehingga

dirancang pula modul sensor array TGS seperti Gambar 3.2.

JP1 JP2
R R2
[ ) [ )
2610 A 2 3 2611 AN 2 3
Ok

1 TGS2610 10k TGS2611

J7 5V LS2 5V
[o] o]

FPAAL 1 1 ADCO 1 ADC2 6
FPAAZ 2 610 9§ 612 9 & 5V
FPAA3 3 Ta5  FPAAL TA5  FPAA3
D2 i 4 ADCL D2 [
611 12 i g A 12 g
Serial IN5402 4.8  FPAR2 IN5402 28
13 13
d 14 ¢ d 14 ¢
R5 :t R5 jk
pPD3 Q3 T85N-DPDT PD4 @ T85N-DPDT
VN TIP31 VY N TP3L
10k 10k

Gambar 3.2. Rangkaian modul sensor array TGS

Pada Gambar 3.2, satu relay yang digunakan untuk memilih tegangan V¢
dan Vy dan dua relay yang digunakan untuk memilih output dari TGS, yaitu untuk
diarahkan ke microcontroller atau ke FPAA. Resistansi yang digunakan pada nilai
resistor beban (R.) adalah 10 kQ sedangkan nilai hambatan sensor (Rs) pada
datasheet rata-rata 0,68 kQ sampai 6,8 kQ. Gambar 3.3 adalah ilustrasi rangkaian

saat TGS menghasilkan nilai Rs minimal yaitu 0,68

0.68 k

VRL

RL
10k

Gambar 3.3. Rangkai_an sensor dengan Rs = 0,68 k
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Perhitungan rangkaian pada Gambar 3.3 adalah sebagai berikut:

Romin = 0,68 kQ

yoo— v 3.3
RL_RSmin+RLxC ()
10000

- x5= 4682
Ver = 580+ 10000 ¥ ° = 82 Volt

Ve = Vr)? (5 —4.682)2
R B 680

Ps = = 1,4871 x 10" *Watt

Perhitungan diatas menghasilkan nilai Ps = 1,4871 x 10 sehingga masih di

bawah 15 mW, kemudian rangkaian saat Rs max terlihat pada Gambar 3.4.

VRL

RL
10 k

Gambar 3.4. Rangkaian sensor dengan Rs = 6,8 k

Perhitungan rangkaian pada Gambar 3.4 adalah sebagai berikut:

Rsmax = 6,8 kO
R, = 10kQ
Ry
VRL = X VC (34)

RSmax + RL
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y. — 10000 5= 29762 Volt
RL = 6800 + 10000 >~ “ 0

Vo=V )? (5 —2.9762)2
p, = Ve . r)” aoo ) _ 6,0232 x 10~ *Watt
S

Perhitungan diatas menghasilkan nilai Ps = 6,0232 x 10 sehingga masih dibawah
15 mW dan dapat disimpulkan dengan resistor beban (R.) = 10 kQ adalah cukup
optimal.
3.2.2. Minimum system

Minimum system ini dirancang untuk microcontroller ATmega8(L),
dalam perancangannya ini memerlukan beberapa komponen pendukung
seperti kristal, resistor dan variabel resistor, dan kapasitor. Rangkaian ini
dalam istilah lainnya disebut minimum system ATmega8(L). Microcontroller
berfungsi untuk mengatur pengambilan data analog dari sensor array TGS
menuju personal komputer maupun FPAA. Di dalam microcontroller ATmega8
sudah dilengkapi dengan ADC vyang terletak di pin PCO — PC5, pin yang
digunakan untuk membaca hasil keluaran dari sensor array TGS. Gambar
minimum system ATmega8 dapat dilihat pada Gambar 3.5, sedangkan Tabel 3.1

adalah rincian alokasi pemakaian port-port 1/0.

Ic1

PC6 (RESET)(SCL/ADC5) PC5 *3—* Sé/

PDO (RXD) (SDA/ADCA) PC4 [~56—X

PD1 (TxD) (ADC3) PC3 [H5e—% e

PD2 (INTO) (ADC2) PC2 ADEL o - c10

PD3 (INT1) (ADC1) PC1 ADCO U =i

PD4 (XCK/TO)  (ADCO) PCO " n N 100/16v

vee AGND 51— "0 c7 c+ 8 2

GND AREF 8 v+

PB6 (XTL/TOSC1) avee [0 x L 1ou/16v ﬁ‘"‘ c1- s

PB7 (XT2/TOSC2) (SCK) PB5 L V-

PD5 (T1) (MISO) PB4 4
15 PD6 (A\NO) OCQ/MOS\) PB3 co+ N
> PD7 (AIN1)  (SS/OC1B) PB2 | 1ou/1C63 =S 5 flou/16v T cu
~*— PBO (ICP) (OC1A) PB1 | —c2 — 7

ATmegas- r&a&—‘l

PD1 X
swi oy Downloader 1l Tour 4 D 1
dJ 220 PDO
12 R1OUT R1IN 13 El
eset
10k 20 oy T20UT [H—% = Serial
teo N *—2droout 2 Ran [B—x
[0}

= reset =
sw1 =

R8 /Y\ 10uF/16v

Gambar 3.5. Minimum system ATmega8
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Tabel 3.1. Alokasi port I/0 pada microcontroller
Port Alokasi

PCO-PC2 Jalur ADC channel 0 sampai channel 2
untuk pembacaan sensor array TGS
PDO dan Jalur pengiriman data serial (RX
PD1 danTX) yang disalurkan ke PC
PD2,3dan 4 | Jalur untuk mengontrol relay
PD5,6 dan Jalur input tombol
PB 1

Pin VCC diberi masukan tegangan operasi berkisar antara 4,5 volt
sampai dengan 5,5 volt. Pin RESET berfungsi untuk masukan reset program
secara otomatis atau manual. Sedangkan pin MOSI, MISO, dan SCK digunakan
untuk  keperluan pemrograman microcontroller. Nilai kapasitor yang
digunakan adalah 30 pF. Frekuensi kristal yang dipakai adalah 8 MHz.

a. Setting software codevision AVR

Sebelum menggunakan software codevision AVR sebagai downloader,

pertama-tama harus melakukan penyetelan pada software ini. Berikut adalah

langkah-langkahnya:

1. Padatampilan awal software terdapat menu bar pada bagian atas.

2. Pilih file => new, selanjutnya akan muncul dialog Create New File,
pilih project => OK. Dialog Create New File dapat dilihat pada Gambar 3.6.
Kemudian akan muncul dialog AVR Chip Type dengan dua pilihan seperti
yang terlihat pada Gambar 3.7, lalu pilih ATMega karena sesuai dengan jenis

yang digunakan dalam tugas akhir ini.

[3 Create New File ﬁ

File Type
) Source Ok

@ Project x LCancel

Gambar 3.6. Tampilan dialog Create New File




43

&b CodeWizardAVR =)

AR Chip Type
(@) ATI0, ATting, ATmega, FPSLIC

) ATsmega

Gambar 3.7. :Fampilan dialog AVR Chip Type

Kemudian tampak dialog CodeWizardAVR - untitled.cwp. Dialog
CodeWizardAVR — untitled.cwp dapat dilihat pada Gambar 3.8.
Ubah bagian tab Chip, pilih seri microcontroller yang sesuai dengan

yang digunakan, ATmega8L. Nilai Clock (komponen kristal) yang

digunakan 8.000000 MHZ.

£k CodeWizardAVR - untitied.cwp IR
File Program Edit Help
=g =E-JIcR 3 B
USART | Analog Comparator | ADC | SPI
12C 1 Wire Twl [12C)

_ Alpharwmeriz LED
BitBanged |  Project Infamation

Chip | Pots | EstemallAQ | Timers

Chips [ATmegsfl ~|

Clock: 8.000000 Z‘ MHz

[T Check Reset Source ‘

Program Type

Gambar 3.8. Tampilan dialog CodeWizardAVR — untitled.cwp

Untuk mengaktifkan ADC pada tab ADC pilih ADC Enabled dan Use 8

bits. Volt. Ref => AREF pin. ADC Clock => 1000.00 KHz. Berikut adalah

tampilan setting ADC pada Gambar 3.9.

(&b CodeWizardAVR - unmmp-

File Program Edit Help
e H®EaQ 8 B?

12C [ twie [ Twinag |
Alphanumeric LED
Bit-Banged | Praject Information
Chip Partz External IR Timers
USART | Analog Comparatar | 4DC | 5P

ADCEnabled [¥] Use 8 bits
[ Interupt

Vol Ref: [4REF pin =
Clock: | 1000,000 kHz -

Gambar 3.9. Tampilan setting ADC
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6. Karena menggunakan komunikasi serial maka buka tab USART, lalu pilih
receiver dan transmitter kemudian setting baudrate 9600, komunikasi
parameter 8 Data, 1 Stop, No Parity lalu mode Asynchronous. Berikut adalah

tampilan setting ADC pada Gambar 3.10.

B oot

Eile Program Edit Help
Dedw s =B

12c | twie | Twapam |
Alphanumeric LCD

BitBanged | Froject Information
Chip | Pots | Estemal IR | Timers
USART | Analog Comparetor | ADC | 5P

Receiver [ R Interupt

Transmitter  [] Tx Intermipt

Baud Rate: 3600 R w2
Baud Rate Enor: 0.2%
Comrurication Parameters:

8 Data, 1 Stap, Mo Parity -
Made: | Aspnchronaus -

Gambar 3.10. Tampilan setting USART

7. Pada menu bar pilih Program, pilih Generate, Save and exit. Ketiga-tiganya
simpan dengan nama yang sama.
8. Selanjutnya tampak kode program pada software codevision AVR. Dapat

dilihat pada Gambar 3.11.

¥ CodeVisionAVR - EABismilah_bersih_mugsith\Lp [0

FEile Edit Search View Project Tools Settings Help

beS-HEadEGMERS. ¢ @ > B|S|EE %] e-0~-3 2|8 B« B¢
Mo spRm BN ROLGEEL RN, BEss, Eaksm. 7 NG,

EHST [EeYEa0sEaS.

f&:: Code Navigator 2 (3 | [EABismilab_bersih_mugsiti].c
=-5¥ CodevisionsvR NV 1@ =
- Project: 1
-3 Notes 18 P
1.c 2 This program was produced by the ‘7|
=l Headers 3 =2
~B ctypeh 4
delaph 5 :z, HP InfoTech s.r.1.
~B megabh &
megal_bits.h 7
stdarg.h 8
~B stdioh 9
stdibh 10
{8 Other Files 11
12
13
14
15 -
H Messages vig
B froe | B waniss
522 Inset  Codelnformation may be incomplete, as the file was modified since last Compile/Build

Gambar 3.11. Tampilan kode program
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b. Download program dari komputer ke microcontroller

Sebelum download program dari

komputer, lakukan setting pada

software CVAVR dengan cara sebagai berikut:

1. Pilih menu Setting => Programmer.

2. Tampak kotak dialog Programmer Setting. Ubah tipe pada AVR Chip

Programmer Type untuk microcontroller AVR ATmega8 (L) “Kanda

System STK200+/300”, kemudian OK, tampilan Programmer Setting

dapat dilihat pada Gambar 3.12.

| # Programmer Settings ot
&R Chip Programme Type:

4| [Kanda Spstems STK200+/300 -
Fiinter Port: [LPT1 27en |

Delay Muliplier 1 z]

| ATmegal 63 CKDIVE Fuse Waming

‘ \/ Ok I |x§ance\‘

|2 teb |

Gambar 3.12. Setting downloader Kanda‘System STK200+/300

3. Pilih menu Project => Configure => Tab After Build => pilih Program the

Chip => OK. Seperti yang ditunjukkan pada Gambar 3.13.

B oot o | =2
Files | C Compie | Befors Buid | After Buid |
Frogiam the Chip  [] Execute User's Frogram
[“]Merge data from a .RiOM Fie for FLASH Programming
Chip Programming Options
SCK Freq.: (450800 < |Hz [] Progiam Fuse Bit(s}
FLASH Lock Bis AT
® Mo Frotection [T CKSELT-0
_ [T CKSELZ-0
() Programming disabled [~ CKSEL3=0
- [ 5UTD-0
*) Programming and Verfication disabled F Bt
BODEN=0
Boot Lock Bit 0 Boat Lock Bit 1 F BODLEVEL=0
@ Bo1=1 Bo2=1 @ Bl1=1B12-1 EOOTRST-0
§ ; F BOOTSZ0-0
©) BOT=0B02-1 7 B11=0B12-1 BOOTSZ1=0
- - F EESAVE=D
© BO1=0B02-0 © BI1=0B12-0 CROPT=0
- . [ WDTON=0
) B =1 B02=0 @ Bn=1g12-0 | RSTDISBL=0
|
i
Il
[7] Check Signature [7] Check Erasuie [ Freserve EEPROM [7] Veriy
FZ a0 [ o raneat ] 2 nan ]

Gambar 3.13. Tampilan Dialog Configure Project
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4. Pilih menu Project => Build (Shift+F9), tampil dialog Information =>

pilih Program, dialog information dapat dilihat pada Gambar 3.14.

€ Information L=

Compiler | Assernbler | Programmer

Chip: ATmega?
Clock frequency: .000000 MHz
Program type: Application

Mernory model: Small

Optimize for. Size

[sJprintf features: i, wicth

|| [slscant features: ini widih
Promote ‘char' to fint": Yes

“char' is unsigned Yes

globial ‘zanst stored in FLASH: Na
& bit

No sitcrs
Na warmings

Bit vaniables area (42 to 0x2
Bit variables size: 1 bytefs)

Data Stack area: 0460 to 01 5F
Data Stack size: 256 bytels)
Estimated Dats Stack usage: 32 bytels]

RAM Global v ear 0160 to D163
Global

RAM e 4 bytels)
Hardw 0164 t0 Oxd5F
Hardw TE4 bytefs)

Heap sizz: Obytels)

EEPROM usage: D bytefs), 0.0% of EEPAOM
Frogiam size: 716 words (1432 bytes], 17.5% of FLASH

‘ 4 Program the chip || x ;ancel‘

Gambar 3.14. Tampilan dialog Information

3.2.3. Interface RS232

Interface  RS232 merupakan suatu jembatan dalam  metode
komunikasi serial. Dalam perancangannya komponen yang digunakan adalah
IC MAX232 dimana komponen pendukungnya lima buah kapasitor dengan
nilai 10uF yang terhubung pada pin C1, C2, V+, V-. Penggunaan komponen
ini dimaksudkan untuk komunikasi serial antara rangkaian demodulasi FSK
dengan komputer. MAX232 ini akan mengubah level tegangan TTL data

serial RX dan TX. Rangkaian Interface RS232 dapat dilihat pada Gambar 3.15.
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7w = Serial
8 4
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o)
=

Gambar 3.15. Réngkaian Interface RS232

3.2.4. Konfigurasi FPAA AN231K04

Alokasi port /0O pada FPAA tersusun pada Tabel 3.2.

Tabel 3.2. Alokasi port I/0 pada FPAA
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Port Alokasi
I11P Jalur Input dari sensor TGS 2610
I12P Jalur Input dari sensor TGS 2610
I13P Jalur Input dari sensor TGS 2610
I0O5P/O5P Jalur Output Indikator LED satu
IO6P/O5P Jalur Output Indikator LED dua
Pin VCC diberi masukan tegangan minimal 4 volt sampai dengan

maksimal 12,5 volt dan tegangan optimal sekitar 5 volt. Untuk melakukan proses

downloading program dari komputer ke dalam memori program internal FPAA,

dapat memilih antara Interface USB dan Serial RS232. Caranya dengan

menghubungkan jumper pin atas dengan pin tengah jika menggunakan serial

RS232 dan jumper pin tengah dan pin bawah untuk menggunakan USB , pada

Gambar 3.16 merupakan jumper yang dipasang untuk mengaktifkan Interface

serial RS232.
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Serial RS232 USB

B Yaizm] E -
Gambar 3.16. Konfigurasi Jumper Serial RS232 dan USB

Selain merancang, program AnadigmDesigner®2 juga dapat disimulasikan
sebelum di download kedalam Hardware FPAA. dengan cara pilih menu
Simulate => Begin Simulation, atau tekan F5. Kemudian sebelum download
program, pastikan FPAA sudah terhubung dengan interface PC/Laptop. Dan
samakan setting COM Port pada AnadigmDesigner®2 dengan COM Port pada
device manager. Untuk AnadigmDesigner®2 dengan cara pilih menu Setting =>
Preferences => Port. Pada Gambar 3.17 tampilan pengaturan COM pada
AnadigmDesigner®2 dan Gambar 3.18 device manager pada PC/Laptop.

e —

Chip | CAM | Wires | Pot | Misc

Select Port

COM1 - Silicon Labs CP210x USB to UART Bridge: -

(COM1 - Silicon Labs CP21(k USB to UART Bridge:
Status of selected port:

Part is available and ready for use.

[ = e .

Gambar 3.17. Tampilan setting COM Port pada AnadigmDesigner®2.
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) U LS pun iy uevies
> {5 Modems
.. Monitors
- Network adapters
» I Portable Devices
477 Ports (COM &LPT)
" Silican Labs CP210x USB to UART Bridge (COML)
D Processors

Gambar 3.18. Tampilan setting COM Port pada device manager.

3.3. Perancangan perangkat lunak

Selain hardware yang diperlukan pada perancangan dan pembuatan alat
ini, juga diperlukan software/ program pada microcontroller, komputer dan
juga FPAA untuk dapat bekerja sesuai dengan fungsinya. Perancangan
perangkat lunak pada microcontroller dirancang agar dapat mengatur proses
pengambilan data dari sensor array TGS menuju komputer dan juga pengujian
jaringan saraf tiruan pada FPAA.
3.3.1. Perancangan program pada microcontroller

Flowchart untuk program pada microcontroller dapat dilihat pada Gambar

3.19.
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START

hl

A
SENSOR TGS ON

CAIRAN GAS
DIMASUKKAN
0.7 ml

4
READ_ADC AKTIF &
SERIAL USART
DIBUKA

hl

DATA
ANALOG T
SENSOR

ARRAY TGS

STOP

Gambar 3.19. Flowchart program pada microcontroller

Adapun penjelasan dari bagan alir di atas adalah sebagai berikut:

1. Proses awal dimulai dengan mengaktifkan sensor array TGS selama 120
detik untuk proses pemanasan sensor.

2. Setelah sensor sudah panas, gas dimasukan pada tabung yang telah
disediakan, kemudian program akan mengaktifkan fungsi ADC pada

microcontroller dan proses pengambilan data tegangan analog dimulai.



o1

3. Data dari sensor array TGS diambil sebanyak 10 data berturut-turut
kemudian dikirim secara serial menuju PC/laptop.

3.3.2. Perancangan program Visual Basic 6 pada komputer

Dalam tugas akhir ini dirancang dua buah program visual, yang pertama
program dirancang agar dapat menerima data yang telah dikirim secara serial oleh
microcontroller kemudian disimpan ke dalam database. Program kedua
merupakan pelatihan jaringan saraf tiruan yang menggunakan metode perceptron.
Program dirancang agar dapat mengenali pola sesuai masukan sensor dan
keluaran yang telah ditentukan sebelumnya sehingga menghasilkan nilai bobot
dan bias yang sesuai dan selanjutan nilai-nilai tersebut digunakan pada FPAA.
a. Program pengambilan dan penyimpanan data ke dalam database

Seperti yang sudah dijelaskan sebelumnya, pada sub ini adalah program
pertama yang difungsikan untuk mengambil data. dan pada Gambar 3.20 adalah

flowchart dari isi program.
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INISIALISASI
VARIABEL;
PORT SERIAL;
TIMER;

Y

TEKAN
TOMBOL ON

A 4

COM SERIAL
AKTIF

TERIMA
DATA SERIAL

KONVERSI DATA KE VOLT
X1 = (xxx/ 255) *5

v

SIMPAN /
DALAM

DATABASE |

I

v
STOP

Gambar 3.20. Flowchart pengambilan dan penyimpanan data ke dalam database

Proses awal adalah proses inisialisasi PORT serial pada komputer sebagai
input, tujuannya agar microcontroller dapat berkomunikasi dengan baik
dengan komputer. Selanjutnya apabila ada penekanan tombol ON maka yang
dilakukan pertama kali adalah mengaktifkan jalur COM serial, terima data

dari sensor, data bilangan bulat 0 — 255 dikonversi menjadi 0 — 5 seperti
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tegangan ADC dalam format tipe data string, kemudian data disimpan kedalam
database untuk selanjutnya digunakan dalam pelatihan jaringan saraf tiruan.
Berikut ini adalah langkah pembuatan program pada komputer dengan
menggunakan program visual basic 6:
I.  Inisialisasi komunikasi serial
Pada saat melakukan inisialisasi komunikasi serial di pemrograman visual
khususnya program VB ada komponen yang harus digunakan adalah
komponen Microsoft comm control 6.0. lebih jelasnya lihat Gambar 3.21
perlu diketahui bahwa komponen ini masih tersimpan di dalam data base
komponen program VB. Untuk memunculkannya yang harus dilakukan adalah:
1. Pilih kanan pada Toolbox general (lihat Gambar 3.22), pilih component
kemudian akan muncul dialog components lihat Gambar 3.23. pada tab

control pilih Microsoft comm control 6.0. Kemudian pilih apply dan close.

£

Gambar 3.21. Komponen Microsoft comm control 6.0.

General

Gambar 3.22. Toolbox general
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["IMicrosoft Chart Control 6.0 (OLEDB) = | ooe
" = = = [ Ti: an
Microsoft Comm Control 6.0 — - | ==
[ Microsoft Common Dialog Control 6.0 (SP&) =5 o =y
[ Microsoft Data Bound Grid Control 5.0 (SP3) =
[[] Microsaft Data Bound List Controls 6.0 AN |

[ Microsoft DataGrid Control 6.0 (OLEDB)
[ Microsoft DataList Controls 6.0 (QLEDE)
["IMicrosoft DataRepeater Control 6.0 (OLEDE)

[ Microsoft DDS 80 -
[ Microsoft DTC Framework - rOWSE. .. |

< ] | r [ Selected Items Only

r~Microsoft Comm Contrel 6.0
Location:  C:\Windows\system32YMSCOMM32.0CX

Ok I Cancel | Apply |

Gambar 3.23. Dialog components Microsoft comm control 6.0.

2. Setelah itu komponen Microsoft comm control 6.0. ini akan muncul

pada Toolbox general lihat Gambar 3.24.

Gambar 3.24. Komponen MSComm muncul pada toolbox general

Penulisan intruksi ke dalam program

MSComml .PortOpen = True
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Maksudnya komponen MSComm telah aktif dan siap melakukan
komunikasi dengan aplikasi dari luar. Selanjutnya pengaturan parameter
dari MSComm, dalam hal pengaturan parameter harus mengerti beberapa
hal yang harus disesuaiakan dengan hardware yang digunakan misalnya
kebutuhan akan nilai dari baudrate yang digunakan, jumlah bit dalam satu
paket data, parity check dan stop bit yang digunakan. Parameter serial
yang digunakan adalah baudrate 9600bps, 8 bit data, no parity check
dan menggunakan 1 stop bit yang telah disesuaikan dengan modul

microcontroller, untuk lebih jelasnya dapat dilihat pada Gambar 3.25.

Property p;ges ‘ l'i'J
General | Buffers | Hardware |
CommPar: [
Settings: |9600.0,81
Handshaking: [0 comMane £
:
[Tox | concel | | Help |

Gambar 3.25. Pengaturan parameter komponeﬁ MSComm

4. Pengaturan pada proses penerimaan data menggunakan MSComm berikut

adalah potongan programnya.

data = MSComml. Input

Maksud dari potongan program tersebut adalah jalur MSComm pada jalur
input mempersilahkan data yang masuk untuk diterima kemudian disimpan pada

variabel data.
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ii. Membuat Database

Pada saat melakukan inisialisasi komunikasi serial di pemrograman visual
khususnya program VB ada komponen yang harus digunakan adalah
komponen Adodc dan DataGrid untuk lebih jelasnya lihat Gambar 3.26 perlu
diketahui bahwa komponen ini masih tersimpan di dalam database komponen
program VB maka dari itu untuk memunculkannya dilakukan cara yang sama

seperti pada komponen Microsoft comm control 6.0.

& o

Gambar 3.26. Komponen Adodc dan DataGrid

Gambar 3.27. Adalah daftar komponen yang dipilih.

;IComponants TITL.I17Y X

Controls IDes@ners 1 Insertable Objects ]

Mathworks: Toggle by GMS
MB Splitter Control 1.1

W Microsoft ADO Data Control 6.0 (OLEDE)
Microsoft Calendar Control 8.0

Microsoft Chart Control 6.0 (OLEDB) T
Microsoft Comm Control 6.0 B
Microsoft Common Dialog Control 6.0 (SP&)
Microsoft Data Bound Grid Control 5.0 (5P3)

Microsoft Data Bound List Controls 6.0
W Microsoft DataGrid Control 6.0 (OLEDE)
Microsoft Datalist Controls 6.0 (OLEDE)

Microsoft DataRepeater Control 6.0 (OLEDE) E

| selected Ttems Only

:-) VideoSoft vsFlex3 Controls
Location: ~ C:\Windows\system32{VSFLEX3.0CX

’T‘ Cancel | |
Gambar 3.27. Dialog components Microsoft ADO Data dan Data Bound Grid

Langkah selanjutnya yaitu membuat database dalam bentuk tabel, dan
dalam membuat tampilan tabel dengan menggunakan fasilitas dari Microsoft
Office Access yang di-load ke dalam program, untuk proses pembuatannya
adalah pertama merancang design view, untuk lebih jelasnya dapat dilihat pada

Gambar 3.28 dan Gambar 3.29 merupakan datasheet view.
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Microsoft /

Home  Creste  ExternalData  Database Tools Design
E ? s SlnsertRows [ﬂ
o — =¥ Delete Rows =
View || [Primany| Builder Test Validation Froperty Indexes
Key Rules 250 Lookup Column | spreet

Views Tools Show/Hide

All Tables ~ < || = Tabler

Tablel ES Field Name Data Type

0 Tablel : Table #* No| Number
TGS2610 Number
TGS2611 Number
TGS2612 Number

Description 4

Field Properties

General |Lookup)|

Field Size
Format
Decimal Places
Input Mask
Caption
Default Value
Validation Rule
Validation Text
Required No

Indexed Yes (No Duplicates)
Smart Tags
Text Align

Long Integer

Auto

General

The maximum number of characters you can
enterin the field. The largest maximum you
can set is 255. Press F1 for help on field size.

Design view. F6 = Switch panes. F1= Help.

Gambar 3.28. Design view

E] Tablel: Table

Home Create External Data Database Tools Datasheet
A ——
& B = = New X Totals |4} V2 Selection ~ 25 Replace
Calibri -l - =|||| IS
& E 43 \Q Hsave  Fopeling | £l 9 Advanced ~ j} = GoTo~
View | Paste \ - =|[FR- |2 - = i=|[ab7 -||| Refresh Filter Find
- = ‘ M\A_lg ,'L@_ |‘ | E=EE]| | Al | X Delete - HMore - || 45 W Toggle Filter l¢ Select~
iews | Clipboard WJI Fopt [ T Rich Text Records Sort & Filter Find
All Tables '« || =] Tabler x
Tablel £

4 No - TGS2610 ~-| TGS2611 - TGS2612 - Add New Field
*

Record: M ¢ Lofl [ | & |Searm

Datasheet View

Gambar 3.29. Datasheet view

|EEEE

file.accdb dari Micrsoft office access disimpan dengan nama Databasel, file

dipindahkan ke folder program, pada control panel => Administrative Tools

Data Sources (ODBC) => Add => Microsoft Access Driver (*.mdb, *.accdb)

Finish. Hasil akhirnya terlihat pada Gambar 3.30.

=>

[l
Y
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D!

Select a driver for which you want to set up a data source

I
Name b5 |
? Microsoft Access Driver (*mdb} [3
] I3
Microsoft Acgess Paradax Driver (*db) 15

Microsoft Access Text Driver ("bd, “.csv) 1
Microsoft Access-Treiber {"mdb) €
Microsoft dBase Driver (*.dbf) €
Microsoft dBase VFP Driver (*.dbf) € out how to connect to
e ERES lis only visible to you,

] m 3

< Back Finish Cancsl
Gambar 3.30. Setting Microsoft Access Driver pada Control Panel

Setelah selesai akan muncul jendela ODBC Microsoft Access Setup seperti
pada Gambar 3.31, pilih Select untuk mencari file .accdb yang telah dibuat dan
disimpan pada directori tertentu. Pilih file tersebut lalu pilih OK, untuk lebih
Jjelasnya dapat dilihat pada Gambar 3.32 pada jendela sebelumnya pilih OK pada

menu bar.

ODBC MicmsﬂkAccessSelii " D e |
e el SR . .
Data Source Name: | IR Duox 1 '
I Descrption [
-
Database
Sdect.. | [ Createw | [ Fepar. ] | Compacte. |
|
System Datebase |
@ None
() Database:
System Database

Gambar 3.31. Tampilan ODBC Microsoft Access Setup

Database Name Directories K

*mdb;" accdb o \documents'tes
Cancel
Database 1.accdb - e -
= Users
& AsUs
(== Documents [F] Riead Oriy
_ | [C)Exclusive

List Files of Type: Drives
Access Databases (m v| =o .

Gambar 3.32. Select Database
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Setelah pengaturan pada control panel, dilanjutkan pada program visual
basic 6 yaitu pada komponen Adodcl, dengan menekan tombol kanan pada mouse
=> ADODC properties. Pilih Use ODBC Data Source Name dan pilih nama file
yang telah dibuat. Pada Gambar 3.33 dipilih karena databasel tersebut yang
dibuat oleh penulis, lalu tekan tombol OK. Selanjutnya pilih Tab RecordSource
pada properties Adodc dan akan membuka jendela seperti pada Gambar 3.34,

pada command type dipilih 2-adCmd Table pada Table or Stored Procedure Name

dipilih tablel.
Property Pages l—&-_]
General ]Auihenﬁcation ] RecordSource ] Color ] Font ]
[~ Source of Connection
© Use Data Link File
| ' Use ODBC Data Source Nams
j New |
£ [giamian i
Pen o __
——|BenchAccess52 Z
b Other Attributes: i
CK Cancel | Apply | Help | l

Gambar 3.33. ADODC Property Pages

Property Pag o E% =
RecordSource I
RecordSource
Comman d Typ
|2-adCmdTable ~|
Table or Stored Procedure Name

l =

Comman d Texd (SQL)

[ox | can | Apply | Help ‘
Gambar 3.34. Record Source ADODC

Langkah selanjutnya setelah pengaturan ADODC adalah pengaturan pada
DataGrid. Pada DataSource yang terdapat pada propeties dari DataGrid dipilih

Adodcl => lalu pilih kanan pada komponen DataGridl => pilih Retrieve fields.
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Untuk lebih jelasnya terlihat pada Gambar 3.35, saat proses berhasil tabel pada

DataGridl akan sesuai dengan tabel pada access.

: | [ _ a : HEPS PSP
T ' cu e
— — Copy IEEEE Properties - DataGridl x
[DataGrid1 DataGrid -l
Delete RS Alphabetic | categorized |
------ [ColumnHeaders  True E
Bring To Front [§5E DataMembe
L 'd DataSource -Adudzl >
g DETCOividH - —
View Code geeace Craalcon fhNone) =
Align to Grid oo e
Loioze Specifies source of grid data
A h Properties... G
Wl Retrieve fields : Form Layout x
Lol Clear fields |
Edit . I"“‘"‘” |

" Gambar 3.35. Pengaturan Adodcl dan Retrive fields

Pengaturan yang telah dilakukan sampai saat ini agar database yang dibuat
pada Access dapat terkoneksi dengan program di Visual Basic 6, tetapi jika
direktori file pada kedua program ini berubah maka koneksinya tidak dapat
bekerja sebagai mana mestinya. Untuk itu dilakukan pengaturan connection yang
diawali pada komponen Adodcl. Pilihlah connection string pada properties Adodc
lalu pilih Use Connection String => pilih Build seperti pada Gambar 3.36
sehingga muncul Data Link Properties dan pada tab provider pilih Microsoft
Office 12.0 Access lalu next, setelah itu pada Data Source diisi dengan nama file
access yang telah dirancang seperti pada Gambar 3.37 setelah itu pilih Test
Connections. Jika sudah berhasil terkoneksi akan muncul seperti pada Gambar

3.38 program siap digunakan.
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oo SRR
roperty Pages —

|| General I il
Source of Connection
" Use Data Link File
Browse,
" Use ODBC Data Source Name
=] Mew

£+ Use Connection String
IFmvider=Mimx5uﬁ ACEOLEDB.12 0:Dcta Source=  Build.

Other Attributes I

[ ok | cancel | apuy | e |
Gambar 3.36. Use Connection String

EEETr

Frovider | Cornection | Advanced [ Al

Specify the following to connect to this data
1. Enterthe data seurce and/or lacation of the data
Data Source: Database 1 acedb

Location:

@) Uss 2 specic user name and password:

User name Admin
i
Blank passwor i [C] Allow savin g passwor rd
[ ok ][ Cancel ][ Hew ]l

Gambar 3.37. Pengaturan Data Link Pifoperties

et

Gambar 3.38. Kgneksi data sukses

Saat semua pengaturan sudah dilakukan hingga berhasil, tabel dapat diisi
sesuai dengan format dan rancangan yang sesuai, dengan perintah di dalam kode

program:

Adodcl.Recordset.AddNew

Adodcl.Recordset.Fields ("No") = no

Adodcl.Recordset.Fields ("TGS2610") = x1
Adodcl.Recordset.Fields ("TGS2611") = vyl
Adodcl.Recordset.Fields ("TGS2612") = z1

Adodcl.Recordset.Update
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Penjelasan program adalah pada data fields no diisi sesuai dengan no urut,
kemudian pada fields TGS2610 sampai fields TGS2612 di isi dengan data yang
dikirim oleh sensor array TGS.

iii. Tampilan Program

Tampilan program Pengambilan dan database terlihat pada Gambar 3.39.

p - 3
(5 BIONIC ELECTRONIC NOSE BERBASIS FPAA - Program Pengambilan Pola |5 s eedem

[Ma [TG52E10 [TG52611 [TG52E12

Gambar 3.39. Program pengambilan dan database

b.  Program pelatihan jaringan saraf tiruan menggunakan metode perceptron
Data-data sensor array TGS yang telah diperoleh akan diproses dalam suatu
program yang dapat mengenali jenis gas tertentu sesuai dengan polanya. Pola
tersebut diolah dengan mengunakan salah satu metode jaringan saraf tiruan yaitu
perceptron. Gambaran umum dari neuron layer yang dirancang dapat dilihat pada

Gambar 3.40.
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INPUT 1
TGS 2610

INPUT 2
TGS 2611

INPUT 3
TGS 2612

Gambar 3.40. Rancangan Neuron Layer

Pada Gambar 3.40 dapat dilihat bahwa rancangan neuron layer terdiri dari
tiga unit masukan dan buah bias serta dua buah unit keluaran (Y1 dan Y2). Tiga
buah nilai inputan berasal dari sensor array TGS yang telah disimpan pada
program sebelumnya sedangkan dua buah output memiliki nilai yang nantinya
telah ditentukan sebelumnya untuk dijadikan target. Gambar 3.41 merupakan

flowchart dari isi program pelatihan.



START

4

INISIALISASI
VEKTOR MASUKAN,;
THRESHOLD=0;
TARGET KELUARAN;
BOBOT & BIAS =0;

x=8@0=1,..,n

net=2xiwi+b

i

_ _(1jikanet =20
y = f(net) = {Ojika net <0

Wi (baru) = Wi (lama)
B (baru) = B (lama)

Wi (baru) = Wi (lama) + Xi
B(baru) = B (lama) + (t-y)

Wi (baru) = Wi (lama) + (-Xi)
B(baru) = B (lama) + (t-y)

A 4

Y->
T
L
Y->
L
Y-»
T
\ 4

Wi (baru) = Wi (lama) + 0
B(baru) = B (lama) + (t-y)

Semua keluaran
jaringan == Target

Y STOP

Gambar 3.41. Flowchart pelatihan perceptron
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Adapun penjelasan dari Gambar 3.41 adalah sebagai berikut:

1. Proses awal dimulai dengan inisialisasi semua variabel pendukung, yaitu nilai
input yang berasal dari program pengambilan database dan nilai target yang
telah ditentukan sebelumnya yang dipakai berbentuk bebas (tidak harus
biner/bipolar), threshold, bias dan bobot yang memiliki nilai nol pada awal
proses.

2. Selanjutnya set aktivasi unit masukan x; = s; (i=1,..,n) dan hitung respon unit

keluaran dengan rumus (3.5).

net\= z X, wi + b (3.5)

L

Dan fungsi aktivasi yang memiliki ouput biner seperti pada persamaan (3.6).

1 jikanet = 0

S {Ojika net <0 (3.6)

3. Kemudian perubahan bobot diubah berdasarkan error yang terbentuk dari
selisih antara terget yang diinginkan dengan keluaran jaringan (=f(net)).
Perubahan bobot bukan merupakan hasil kali antara target dengan masukan.
Misalkan p = (X1 Xz ... Xn) adalah masukan yang diberikan ke jaringan dengan
target = t, dan a = f(net). Perubahan bobot yang dilakukan adalah :

P jika(t—a) >0
Aw =< =P jika(t—a) <0 (3.7)
P jika(t—a)=0
whart = wylama 4 Ay (3.8)
bbaru = plama 4 (t-a) (3.9)
Perubahan bobot hanya dilakukan jika target # keluaran jaringan. Setelah

proses pelatihan selesai, nilai bobot dan bias yang dihasilkan, diambil untuk

kemudian diimplementasikan ke dalam FPAA. Kode program dapat dilihat pada
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halaman lampiran, sedangkan tampilan program terlihat seperti pada Gambar

3.42.

f BIONIC ELECTRONIC NOSE BERBASIS FPAA (NEURAL NETWORK TOOL) - Mugsith (08.410... [x=| -l eS|

Layer
(K] Bl 1] Input m Output
0
Delete Epoch .’ d @ Q) »v-
[ 4Jedoder [ »[M] m

IID [Net] [t [dwit [ w1z [dw13

l||w\ 5

Gambar 3.42. Tampilan Program Pelatihan JST dengan meto__dé perceptron

3.3.3. Rancangan Neuron Network pada FPAA

Setelah program pelatihan menghasilkan nilai bobot dan bias yang sesuai,
langkah selanjutnya adalah merancang jaringan saraf tiruan menggunakan
software AnadigmDesigner®2 yang nantinya program akan di download pada
FPAA. Terdapat 10 cell yang dapat difungsikan sebagai input dan output jaringan
dan setiap 10 cell memiliki dua pin yaitu pin negatif dan positif. Sesuai dengan
pegaturan yang dilakukan, dengan cara double pilih pada 10 cell yang dimaksud,
lalu lakukan konfigurasi. Dan pada 10 cell terdapat dua pengkondisi sinyal yaitu
differential dan common-mode yang memiliki rumus seperti pada persamaan

(3.10) dan persamaan (3.11).

VDifferential = VPossitive - VNegative (3-10)

VCM — VPositive';VNegative (311)
Terdapat beberapa mode yang dapat dipilih pada 10 Cell, dan pada Tugas

Akhir ini penulis menggunakan mode bypass, dimana sinyal input disalurkan
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langsung melalui sel, melewati semua elemen sirkuit aktif. Sedangkan sinyal
output dialihkan langsung melalui sel, melewati semua elemen sirkuit aktif. Pin
output di dorong langsung oleh CAM yang memberikan masukan kepada output

cell. Pada Gambar 3.43 merupakan 10 cell yang menggunakan mode bypass.

Gambar 3.43. 10 cell dengan bypass mode

Perancangan jaringan saraf tiruan yang dimulai dari pemilihan chip FPAA
yang terdapat pada program AnadigmDesigner®2, chip FPAA yang dipilih adalah
AN231K04. Karena disesuaikan dengan hardware yang akan digunakan. Untuk
memilihnya dengan cara pilih tombol kanan mouse pada halaman project yang
berwarna hitam, kemudian Insert new chip => AN231E04. Untuk lebih jelasnya

terlihat pada Gambar 3.44.

File Edit Simulste Configure Settings Dynamic Config. Target View Tools Help

D S % A S || BN

LOAD ORDER:1

Help me choose...

i Insert New CAM

~ Create Signal Generatar
% Create Oscilloscope Probe

AMN220E04
AN120E04

ANZZLE04

l‘;';‘ Write Configuration Data te Serial Port.
AN121E04

[ Paste

AN227E04
AN12TE04 l Select Al

AN231E04 Preferences...

AN131E04

4 m b

| Gambar 3.44. Pengaturan chip FPAA

1. Perancangan komponen-komponen jaringan saraf tiruan, dengan pilih kanan

=> pilih Insert New CAM, terlihat seperti pada Gambar 3.45 kemudian



68

muncul jendela baru seperti pada Gambar 3.46. Pilih => sumdiff => Create
CAM dan letakkan pada FPAAL, setelah itu akan muncul Set CAM Parameter
dari komponen yang dipilih atau bisa dengan melakukan double pilih pada

komponen yang dimaksud.

Insert New Chip 3
k™ Insert New CAM M
~y Create Signal Generator G
)(jl Create Oscilloscope Probe P
"' Write Configuration Data to Serial Port. Ctrl+W
Paste Chri+V
Select All Ctrl+A
Preferences...

Gambar 3.45. Insert New CAM

7 e
¥ - - - -

- Chip Type CAM Description Version Approved | createcam |

41+ Function . Vi imiti =) Yesg*®

o EI Archive Ga!nle\tFTr Gain Stage with Output Voltage Limiting ] .ras | Archive CAM ‘
GainPolarity Gain Stage with Polarity Control '] Yes
GainSwitch Gain Stage with Switchable Inputs * Yes | Documentation ‘
GainVoltageCo... Voltage Controlled Variable Gain Stage '] Yes

| Hold sample and Hold ® Yes | Close ‘
I HoldVoltageCo... Voltage Controlled Sample and Hold ™ Yes | | Help
Integrator Integrator * Yes
Multiplier Multiplier ™ Yes |
MultiplierFilterL..., Multiplier with Low Corner Frequency LPF (E... () Yes Il
OsdillatorSine Sinewawve Oscillator ™ Yes
PeakDetect2 Peak Detector * ®
etectExt cak D» Exb p
PeriodicWave Arbitrary Periodic Waveform Generator Yes
RectifierFilter Rectifier with Low Pass Filter Yes
RectifierHalf Half Cydle Rectifier Yes ||
RectifierHold Half Cydle Inverting Rectifier with Hold Yes B
SquareRoot Square Root 5] Yes
SumBiquad Sum)Difference Stage with Biquadratic Filter * Yes
e Sum i 5 Ar mE

SumFilter Sum)Difference Stage with Low Pass Filter * Yes
Sumintegrator  Sum/Difference Integrator i) Yes
SumlInv Inverting Sum Stage Yes
TransferFunction  User-defined Voltage Transfer Function Yes
Transimpedance  Transimpedance Amplifier = Yes*®
Voltage DC Voltage Source (] Yes

Gambar 3.46. Pemilihan komponen SumDiff

Pada pengaturan sumdiff, ada beberapa pilihan dan parameter yang dapat
diubah-ubah sesuai dengan kebutuhan, seperti yang terlihat pada Gambar 3.47.
Pada Gambar 3.47 terdapat dua input inverting dan non-inverting serta memiliki
Gain=1 di setiap inputnya. Gain pada sumdiff yang terdapat pada chip AN231E04
memiliki range 0,01 — 3,92. dan sumdiff memiliki rumus sesuai dengan persamaan
(3.12).

Vout =t Gl Vlnputl t GZ Vlnput2 t GS VInput3 t G4 Vlnput4 (3-12)



69

=t CAM Parameters

Instance Mame:  SumDiffl AnadigmépexhS umDiff 1.0.0 (Half Cycle Sum/Difference Stage)
Cancel

Hlocks ARNING
ClackA | ClockD (4000 kHz) - It is not recommended to route the output of this Céb to an
Output Cell when this CAM's clock [CLOCKA] has &

frequency greater than 2 MHz.

Help

Documentation

o
=

BRAMING
C Code.
-
Options Tl
Qutput Phase: * Phase 1 " Phase 2
Input 1: " Non-inverting @ Inverting
Input 2: " Non-inverting & Inverting
Input 3: C off * Mon-inverting " Inverting
Input 4: " Off " Non-inverting " Inverting
Opamp Chopping: [~ Enabled £
Parameters
Gain 1 (Upperlnput): 1 (1.00 realized)  [0.0100 To 3.92]
Gain 2 {SecondInput): 1 (1.00 realized)  [0.0100 To 3.92]
Gain 3 (ThirdInput): 1 (1.00 realzed)  [0.0100 To 3.92]
Gain 4 (LowerInput): |1 (1.00 realized)  [0.0100 To 3.92] L4

Gambar 3.47. Pengaturan Sumdiffl

Hasil penjumlahan dari sumdiffl akan diteruskan menuju komponen
komparator yang merupakan persamaan dari fungsi aktivasi, yang juga

memiliki pilihan konfigurasi seperti yang terlihat pada Gambar 3.48.

s pwarere: N B R 5
.

Instance Mame:  Comparator? Anadigmépex\Comparator 1.1.0 [Comparatar]
| canes |
Clacks T N —
Mo notes] | Help |
|| Clocks [Ciockn (2000 kH2) -] L=
| Dozumentation |
Clode.. |
Options

Compare To: + Signal Ground ¢ Dual Input " Wariable Reference

Input Sampling: % Phase 1 " Phase 2
Qutput Polarity: @ Non-inverted " Inverted
Hysterasis: *0mv 10 mv
Qutput Synch: * HNone " Phase 1 " Phase 2

Gambar 3.48. Beberapa konfigurasi pada comparator

Komponen berikutnya yang mendukung pembuatan jaringan saraf tiruan
adalah Voltage, dimana cara pengambilan komponennya sama dengan

sumdiffl dan opsi pengaturannya hanya polarity tegangan positif dan negatif
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dengan besar tegangan 2 volt. Voltage diimplementasikan sebagai bias yang
dikombinasikan dengan sumdiff1.
4. Pada output cell tipe output yang digunakan adalah single-ended digital

dengan konfigurasi seperti pada Gambar 3.49.

Instance Name: | I0CelS ANE3 Type? 10 Cell 1.0.0
Clocks
The 10 cell's autput pins cany independent single-ended
elp
digital signals
-
Options
/O Mode:  off  Input + Qutput
Output Type: " Bypass  Single-ended Digital VMR
Upper Digital Output: ™ Clocka & Comparator " RAM Transfer Pulse
& Non-inverted " Inverted
Lower Digital Output: " Clockg " Comparator & RAM Transfer Pulse
@ Non-inverted ¢ Inverted

Gambar 3.49. Konfigurasi single-ended digital pada output cell

Untuk lebih jelasnya bagaimana ilustrasi dari rancangan jaringan saraf

tiruan dapat dilihat pada Gambar 3.50.

¥ | INPUT 1 ]
TGS 2610 e —
L +

= — 2

TR ]

|
[T1 Y

n

2
(u')

@

7]

o

INPUT 2
% TGS 2611
H ©m
=
]
]
n
] INPUT 3
it TGS 2612
n

Gambar 3.50. llustrasi jaringan saraf tiruan

Setelah membahas tentang perancangan jaringan saraf tiruan pada FPAA,

maka tahap selanjutnya yaitu simulasi. Simulasi pada AnadigmDesigner®2 untuk
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mengetahui  perancangan yang dilakukan benar atau tidak. Setelah simulasi
berhasil maka program di download kedalam Hardware. Hal ini dapat dilakukan
agar mengetahui apakah rangkaian dapat beroperasi sebagaimana mestinya. Pada

Gambar 3.50 merupakan contoh rancangan yang digunakan dalam simulasi.
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Gambar 3.51. Contoh rangkaian JST untuk disimulasikan

Pada software AnadigmDesigner®2, simulasi dapat dilakukan dengan
menggunakan oscilloscope probe yang diletakkan pada titik tertentu, kemudian
akan mengukur serta menampilkan hasil dari suatu sinyal seperti pada
oscilloscope. Tetapi dalam software AnadigmDesigner®2 ini, probe yang bisa
digunakan maksimal ada empat buah saja. Cara mengambilnya adalah dengan
pilih kanan => kemudian pilih create oscilloscope probe atau pilih icon seperti

pada Gambar 3.52 letakkan pada titik yang akan diukur.

v

Gambar 3.52. Oscilloscope probe
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Kemudian pilih icon begin simulation seperti pada Gambar 3.53 dan akan muncul

hasil pengukuran pada Gambar 3.54.

ST

Gambar 3.53. Begin simulation
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Gambar 3.54. Oscilloscope

Save Close

Setelah semua rancangan jaringan saraf tiruan sudah sesuai dengan hasil simulasi
yang diharapkan, lakukan download program dengan cara pilih kanan => write

Configurations data to serial port atau dengan Ctrl + W, seperti yang terlihat pada

Insert New Chip »
i Insert New CAM M
“ Create Signal Generatar G
ﬁ Create Oscilloscope Probe P
' Write Configuration Data to Serial Port. Ctrl+W
Paste Ctrl+V
Select All Ctrl+A
Preferences...

Gambar 3.55. Download program dari AnadigmDesigner®2 ke FPAA

Saat proses download akan terdengar suara “ting-ting” dua kali yang menandakan

download program berhasil dan siap digunakan.
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3.4. Perancangan model sistem
Rancangan model sistem yang dibuat dapat dilihat pada Gambar 3.55

berupa foto sensor array beserta sistem secara keseluruhan.
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Gambar 3.56. Rancangan arsitektur sistem |
Rancangan elektronika dari sistem yang dibuat dapat dilihat pada Gambar
3.56. Rancangan elektronika tersebut tersusun dalam bentuk box dengan ukuran

17x5x11cm, terdiri dari FPAA AN231K04, 2 tombol, 2 LED indikator dan

didalam kotak terdapat rangkaian minimum system, relay serta beberapa potensio.
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Gambar 3.57. Rancangan elektronika

Modul sensor array TGS yang telah dirancang dapat terlihat pada Gambar
3.58. Modul tersebut terdiri dari sensor TGS 2610, 2611, dan 2612. Kotak sensor
berukuran 7x7x7cm, muk/mangkok kecil, dan suntik 3 cc/mL digunakan untuk

memasukkan cairan, agar diperoleh takaran yang sesuai.
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4cm

Gambar 3.58. Rancangan modul sensor array TGS

Injeksi jenis gas pada modul sensor array TGS saat dilakukan sampling dan

pengujian dapat dilihat pada Gambar 3.59.

Gambar 3.59. Injeksi jenis gas modul sensor array TGS.



